
Descubra como construir uma chocadeira artesanal com o 
poderoso microcontrolador ESP8266, transformando o 

processo de incubação em uma experiência automatizada e 
eficiente. Com controle preciso de temperatura e umidade, 
você aumenta as chances de sucesso na eclosão e aprende os 

segredos da incubação profissional, tudo com materiais 
acessíveis e tecnologia fácil de implementar!
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Criando uma Chocadeira 
Artesanal com Isopor e 

Microcontrolador 
ESP8266

Este documento detalha o processo de construção de uma chocadeira artesanal utilizando isopor e o 

microcontrolador ESP8266. Aborda desde a introdução ao conceito até a montagem, programação e 

monitoramento do dispositivo, oferecendo uma solução acessível e tecnológica para a incubação de 

ovos.
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Chocadeira artesanal
A chocadeira artesanal é uma solução viável e econômica para quem deseja incubar ovos em casa, 

seja para fins comerciais ou hobby. Este dispositivo permite replicar as condições ideais para a 

incubação de ovos, oferecendo controle sobre temperatura, umidade e ventilação, fatores essenciais 

para o sucesso do processo de chocar.

Benefícios de Construir uma Chocadeira Artesanal em Casa:

Custo-Efetividade: Construir sua própria chocadeira pode ser significativamente mais barato do 

que adquirir uma industrialmente. Materiais como madeira, isopor e lâmpadas são acessíveis e 

muitos podem estar disponíveis em casa.

1.

Personalização: Ao construir sua chocadeira, você pode adaptá-la às suas necessidades 

específicas. Seja ajustando o tamanho para diferentes tipos de ovos ou implementando 

características adicionais, como automação, a personalização é um dos maiores atrativos.

2.

Educação e Satisfação: O processo de construção e utilização da chocadeira é uma experiência 

educativa. Aprender sobre a incubação e a biologia dos ovos pode ser fascinante e gratificante. A 

satisfação de ver os filhotes eclodindo de um projeto que você mesmo criou é incomensurável.

3.

Sustentabilidade: Ao utilizar materiais reutilizados ou reciclados, é possível construir uma 

chocadeira que não só é econômica, mas também sustentável. Isso se alinha com uma crescente 

conscientização ambiental e práticas de vida responsável.

4.

Controle de Qualidade: Ao monitorar pessoalmente a incubação, você tem a oportunidade de 

manter um padrão de qualidade superior, otimizando as condições para o desenvolvimento 

saudável dos embriões.

5.

Acesso a Recursos: Dividir suas experiências com outros entusiastas, participar de grupos online 

ou comunidades locais sobre incubação pode ser uma ótima maneira de aprender e compartilhar 

conhecimentos, ampliando sua rede e experiências.

6.

Neste eBook, exploraremos como construir uma chocadeira artesanal passo a passo, os tipos de ovos 

que podem ser incubados, além de cuidados necessários durante o processo. Prepare-se para 

mergulhar nesse universo fascinante e colocar em prática suas ideias de forma palpável e produtiva!
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· Apresentação do 
ESP8266 como uma 

solução para 
monitoramento e 

controle da 
temperatura e 

umidade.

A incubação de ovos é um processo delicado que exige 

controle rigoroso da temperatura e umidade. Uma 

chocadeira artesanal bem-sucedida não só depende da 

construção física, mas também de uma gestão eficiente 

dessas variáveis. O ESP8266 surge como uma solução 

inovadora, integrando tecnologia à incubação tradicional.

O que é o ESP8266?

O ESP8266 é um microcontrolador com capacidades de 

conectividade Wi-Fi, amplamente utilizado em projetos 

de automação e Internet das Coisas (IoT). Sua 

popularidade se deve à combinação de baixo custo, 

facilidade de programação e a possibilidade de se 

conectar à internet, permitindo que os usuários 

monitorem e controlem seus dispositivos remotamente.

Benefícios do ESP8266 na Chocadeira

Monitoramento em Tempo Real: Com sensores de 

temperatura e umidade conectados ao ESP8266, é 

possível coletar dados em tempo real, garantindo que 

as condições ideais sejam mantidas durante todo o 

período de incubação.

1.

Automatização da Viragem dos Ovos: A viragem dos 

ovos é essencial para o desenvolvimento adequado 

dos embriões. O ESP8266 pode ser programado para 

acionar um motor que realiza essa viragem 

automaticamente em intervalos regulares, simulando o 

comportamento da galinha.

2.
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Alertas e Notificações: Ao conectar o ESP8266 à internet, é possível configurar alertas por meio 

de aplicativos ou e-mails. Caso a temperatura ou umidade saia da faixa ideal, o usuário será 

notificado imediatamente, permitindo uma ação rápida para corrigir o problema.

1.

Interface Amigável: Com a criação de um painel de controle via aplicativo ou web, os usuários 

podem facilmente visualizar as condições da chocadeira, alterar configurações e programar ciclos 

de viragem.

2.

Registro de Dados: O ESP8266 pode armazenar dados históricos, permitindo que os usuários 

analisem o desempenho da chocadeira ao longo do tempo e ajustem suas práticas para melhorar 

a taxa de eclosão.

3.

Conclusão.

Integrar o ESP8266 a uma chocadeira artesanal não só aumenta a eficiência do processo de 

incubação, mas também traz um nível de praticidade e segurança que transforma a experiência do 

usuário. Com monitoramento constante e automação das funções críticas, os entusiastas da 

incubação podem alcançar melhores resultados e se concentrar no que realmente importa: a eclosão 

de filhotes saudáveis.

Na próxima seção, abordaremos como montar o hardware necessário para integrar o ESP8266 à sua 

chocadeira.
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Montagem do Hardware Necessário 
para Integrar o ESP8266 à 

Chocadeira.

Integrar o ESP8266 à sua chocadeira artesanal exige um planejamento cuidadoso do hardware. Nesta 

seção, vamos detalhar os componentes necessários e os passos para a montagem.

Componentes Necessários

Microcontrolador ESP8266:1.

Você pode escolher entre módulos como o ESP-01, NodeMCU ou Wemos D1 Mini. A escolha 

depende da facilidade de conexão e espaço disponível.

Sensores de Temperatura e Umidade:2.

O sensor DHT11 ou DHT22 são populares para monitorar temperatura e umidade. O DHT22 é 

mais preciso e possui uma faixa de medição mais ampla.

Relé:3.

Um módulo de relé é necessário para controlar a fonte de aquecimento (como uma lâmpada ou 

aquecedor) e, se necessário, um ventilador.

Motor para Viragem dos Ovos:4.

Um motor de passo ou um servo motor pode ser utilizado para automatizar a viragem dos ovos. 

Escolha um que tenha torque suficiente para o mecanismo de viragem.

Fonte de Alimentação:5.

Verifique se a fonte é compatível com o ESP8266 e os outros componentes. Uma fonte de 5V é 

comum para a maioria dos módulos.

Fios e Conectores:6.

Fios jumper e conectores são essenciais para fazer as ligações entre os componentes.

Placa de Prototipagem (opcional):7.

Uma breadboard pode ser útil para testes antes de soldar os componentes em uma placa de 

circuito.

Passo a Passo da Montagem

Configuração do ESP8266:1.

Conecte o ESP8266 à sua máquina e instale o ambiente de desenvolvimento Arduino IDE, se 

ainda não o fez. Adicione a placa ESP8266 às configurações do IDE.

Conexão dos Sensores:2.

Ligue o sensor DHT11 ou DHT22 ao ESP8266. Geralmente, o sensor possui três pinos: VCC (5V), 

GND e DATA. Conecte o pino DATA a um pino digital no ESP8266.

Instalação do Módulo de Relé:3.

Conecte o módulo de relé ao ESP8266. Um dos pinos do relé deve ser conectado a um pino 

digital do ESP8266, enquanto o outro pino vai à fonte de aquecimento.

Instalação do Motor:4.

Se estiver usando um servo motor, conecte os fios de controle ao ESP8266. Para um motor de 

passo, verifique o diagrama de conexão e conecte os fios corretamente.

Alimentação:5.

Certifique-se de que todos os componentes estão alimentados corretamente. O ESP8266 e os 

sensores geralmente operam em 5V, enquanto alguns motores podem exigir uma voltagem 

diferente.

Teste dos Componentes:6.

Antes de finalizar a montagem, teste cada componente individualmente usando códigos 

simples para verificar se estão funcionando corretamente. Isso ajuda a identificar possíveis 

problemas.

Considerações Finais

A montagem do hardware é uma etapa crucial para garantir que sua chocadeira funcione de maneira 

eficiente. Após a montagem, a próxima etapa será a programação do ESP8266 para monitorar e 

controlar as condições da chocadeira. Na próxima seção, vamos explorar como programar o ESP8266 

e integrar os sensores e atuadores para o funcionamento ideal da sua chocadeira artesanal.
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2. Materiais necessários
Listagem dos materiais necessários para construir a chocadeira:

Isopor (placas ou caixas)

Microcontrolador ESP8266

Sensores de temperatura e umidade (DHT11 ou DHT22)

Fonte de alimentação

Termostato (opcional)

Fitas adesivas, tesoura, etc.

Vidrou ou Acrilico (opcional).

Cabo de vassoura e madeira para esteira dos ovos.

Arame, grampo, prego, etc…
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3. Construindo a chocadeira

1 Passo 1: Preparação do Isopor

Cortar as placas de isopor para montar a estrutura da chocadeira. Criar uma tampa 

que permita a ventilação e o acesso aos ovos.

2 Passo 2: Instalação do ESP8266

Conectar o ESP8266 aos sensores de temperatura e umidade. Explicar a necessidade 

de programar o ESP8266 (breve menção ao código utilizado).

3 Passo 3: Montagem do sistema de ventilação

Posicionar o ventilador para garantir a circulação de ar. Explicar a importância da 

ventilação para manter uma temperatura uniforme.

4 Passo 4: Montagem e ajustes finais

Montar tudo de forma segura, utilizando fita adesiva ou cola. Verificar se todos os 

componentes estão funcionando corretamente.
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4. Programação do ESP8266
Breve introdução sobre como programar o ESP8266 usando a IDE do Arduino.

Introdução à Programação do ESP8266 Usando a IDE do Arduino

Programar o ESP8266 é uma tarefa acessível, especialmente com a popularidade da IDE do Arduino. 

Esta plataforma oferece um ambiente intuitivo que permite tanto iniciantes quanto especialistas 

desenvolverem projetos de forma rápida e eficaz. A seguir, vamos apresentar os passos básicos para 

configurar e programar seu ESP8266.

Instalação da IDE do Arduino Caso ainda não tenha a IDE instalada, você pode baixá-la do site 

oficial do Arduino. Após a instalação, abra o programa.

1.

Configuração do ESP8266 na IDE Para programar o ESP8266, você precisará adicionar a placa ao 

ambiente da IDE:

2.

Vá até File > Preferences. Na seção "Additional Board Manager URLs", adicione a seguinte URL: bash 

Copiar código http://arduino.esp8266.com/stable/package_esp8266com_index.json 

Depois, vá em Tools > Board > Board Manager e busque por "ESP8266". Instale o pacote 

correspondente. 3. Seleção da Placa Após instalar, selecione o modelo específico do seu ESP8266 em 

Tools > Board. Por exemplo, escolha "NodeMCU 1.0 (ESP-12E Module)" ou "Wemos D1 Mini", dependendo 

do módulo que você está utilizando.

Conexão do ESP8266 ao Computador Use um cabo USB para conectar o ESP8266 ao seu 

computador. Certifique-se de que a porta correta esteja selecionada em Tools > Port.

1.

Escrita do Código Agora você pode começar a programar! O código geralmente inclui:2.

Configuração de Pinos: Defina quais pinos estão conectados aos sensores e atuadores. Setup: 

Configure a comunicação serial e inicialize os sensores. Loop: Leia os dados dos sensores e controle 

os atuadores conforme necessário. Exemplo básico de código para ler um sensor DHT e controlar um 

relé:

Upload do Código Após escrever o código, clique no botão de upload (seta para a direita) na IDE. 

Isso compilará e enviará o código para o seu ESP8266.

1.

Testes e Debugging Utilize a janela de monitor serial (Tools > Serial Monitor) para verificar as 

leituras e comportamento do seu código. Isso é fundamental para identificar e corrigir possíveis 

problemas.

2.

Conclusão 

Programar o ESP8266 na IDE do Arduino é uma maneira eficaz de dar vida ao seu projeto de 

chocadeira artesanal. Com a configuração adequada e um código funcional, você poderá monitorar e 

controlar a temperatura e umidade, além de automatizar a viragem dos ovos. Na próxima seção, 

vamos explorar como implementar a comunicação via Wi-Fi para monitoramento remoto.

http://arduino.esp8266.com/stable/package_esp8266com_index.json
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Exemplo básico de código para ler um sensor DHT e 

controlar um relé:

#include <DHT.h>

#define DHTPIN 2 // Pino do sensor DHT 

#define RELAYPIN 5 // Pino do relé DHT 

dht(DHTPIN, DHT22);

void setup() { Serial.begin(115200);

 dht.begin();

 pinMode(RELAYPIN, OUTPUT); 

}

void loop() {

 float h = dht.readHumidity(); 

float t = dht.readTemperature();

// Controle do relé baseado na temperatura

 if (t > 30) {

 digitalWrite(RELAYPIN, HIGH); // Liga o aquecedor 

} else {

 digitalWrite(RELAYPIN, LOW); // Desliga o aquecedor

}

delay(2000); // Aguarda 2 segundos antes da próxima 

leitura 

}

Explicação básica do código utilizado para monitorar e 

controlar a temperatura e umidade.

Explicação Básica do Código para Monitorar e Controlar 

Temperatura e Umidade O código que apresentamos 

anteriormente é um exemplo básico de como usar o 

ESP8266 para monitorar a temperatura e umidade com 

um sensor DHT e controlar um relé para ativar ou 

desativar um aquecedor. Vamos detalhar as principais 

partes desse código:

Inclusão da Biblioteca DHT 1.

#include <DHT.h> 

Essa linha inclui a biblioteca necessária para interagir com 

o sensor DHT. A biblioteca facilita a leitura dos dados de 

temperatura e umidade. 

2. Definição de Pinos 

#define DHTPIN 2 // Pino do sensor DHT 

#define RELAYPIN 5 // Pino do relé 

Aqui, definimos quais pinos do ESP8266 serão usados 

para conectar o sensor DHT e o relé. O pino 2 é usado 

para o sensor e o pino 5 para o relé. 

3. Criação do Objeto DHT 

DHT dht(DHTPIN, DHT22); 

Esta linha cria uma instância do objeto DHT, especificando 

qual pino usar e o tipo do sensor (neste caso, DHT22). Isso 

permite que você acesse as funções da biblioteca DHT 

para ler os dados. 

4. Função setup() 

void setup() 

{ Serial.begin(115200); 

dht.begin(); 

pinMode(RELAYPIN, OUTPUT); 

} 

Serial.begin(115200): Inicializa a comunicação serial com 

uma taxa de 115200 bps, permitindo enviar e receber 

dados via monitor serial. 

dht.begin(): Inicializa o sensor 

DHT. pinMode(RELAYPIN, OUTPUT): Define o pino do relé 

como uma saída, permitindo que o ESP8266 controle o 

estado do relé. 

5. Função loop()

 void loop() {

 float h = dht.readHumidity();

 float t = dht.readTemperature(); 

dht.readHumidity(): Lê o valor da umidade e armazena na 

variável h. 

dht.readTemperature(): Lê a temperatura e armazena na 

variável t. 

6. Controle do Relé 

if (t > 30) {

  digitalWrite(RELAYPIN, HIGH); // Liga o aquecedor

} else { 

 digitalWrite(RELAYPIN, LOW); // Desliga o aquecedor 

} 

O código verifica se a temperatura (t) está acima de 30 

graus Celsius. Se estiver, o relé é acionado (HIGH), ligando 

o aquecedor. Caso contrário, o relé é desligado (LOW). 

7. Delay 

delay(2000); // Aguarda 2 segundos antes da próxima 

leitura 

O código aguarda 2 segundos antes de repetir o ciclo de 

leitura e controle. Isso evita leituras muito frequentes e 

permite tempo suficiente para que as condições no 

ambiente mudem. 

Conclusão 

Esse código básico serve como um ponto de partida para 

monitorar e controlar a temperatura e umidade na sua 

chocadeira artesanal. Você pode expandir e personalizar 

essa lógica conforme necessário, adicionando mais 

funcionalidades, como a coleta de dados históricos ou 

integração com um sistema de monitoramento remoto. 

Na próxima seção, vamos explorar como implementar 

essa comunicação via Wi-Fi.
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5. Monitoramento e controle
Importância de verificar regularmente as condições dentro da chocadeira.

Importância de Verificar Regularmente as Condições Dentro da Chocadeira Manter um ambiente 

adequado dentro da chocadeira é crucial para o sucesso da incubação dos ovos. Aqui estão algumas 

razões pelas quais a verificação regular das condições, como temperatura e umidade, é tão 

importante:

Taxa de Eclosão As condições ambientais diretamente influenciam a taxa de eclosão dos ovos. 

Temperaturas inadequadas ou flutuações de umidade podem levar a embriões não viáveis ou 

malformações. Monitorar essas variáveis regularmente ajuda a garantir que os ovos se 

desenvolvam de forma saudável.

1.

Prevenção de Problemas Verificações frequentes permitem identificar problemas antes que se 

tornem críticos. Por exemplo, uma queda na temperatura pode ser um sinal de falha no aquecedor, 

enquanto um aumento inesperado na umidade pode indicar um vazamento. Agir rapidamente 

pode evitar danos irreparáveis.

2.

Consistência das Condições Os ovos requerem condições específicas e consistentes para um 

desenvolvimento adequado. Variações repentinas na temperatura ou umidade podem estressar os 

embriões, prejudicando o crescimento. A monitorização contínua ajuda a manter um ambiente 

estável.

3.

Ajustes Rápidos Com um sistema de monitoramento eficiente, como o uso de sensores 

conectados ao ESP8266, você pode fazer ajustes em tempo real. Isso significa que, se a 

temperatura estiver muito alta, você pode acionar ventiladores ou sistemas de resfriamento 

instantaneamente.

4.

Dados para Melhorias Futuras Registrar as condições dentro da chocadeira ao longo do tempo 

pode fornecer dados valiosos para otimizar futuros ciclos de incubação. Analisar o que funcionou 

ou não permitirá ajustes em projetos futuros e aumentará a taxa de sucesso.

5.

Redução do Estresse dos Ovos Manter um ambiente estável minimiza o estresse nos ovos, o que é 

essencial para o desenvolvimento saudável dos embriões. Condições adversas podem levar a 

problemas de saúde nos filhotes após a eclosão.

6.

Segurança dos Investimentos Incubar ovos envolve um investimento de tempo e recursos. A 

verificação regular das condições garante que esse investimento não seja desperdiçado devido a 

falhas na chocadeira. Um ambiente controlado protege sua produção.

7.

Conclusão Verificar regularmente as condições dentro da chocadeira é uma prática essencial que 

impacta diretamente a taxa de eclosão e a saúde dos filhotes. Com o uso de tecnologia, como o 

monitoramento remoto via ESP8266, essa tarefa se torna mais fácil e eficiente, permitindo que você 

se concentre no sucesso do seu projeto de incubação.
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6. Conclusão

Recapitulação dos benefícios de ter uma chocadeira artesanal feita de isopor e controlada pelo 

ESP8266.

A criação de uma chocadeira artesanal com isolamento de isopor e controle automatizado pelo 

ESP8266 apresenta uma série de benefícios. Primeiramente, o isopor atua como excelente isolante 

térmico, o que ajuda a manter a temperatura interna estável, reduzindo a necessidade de ajustes 

constantes e economizando energia. O controle pelo ESP8266 permite monitorar e regular a 

temperatura e a umidade com precisão, essenciais para o desenvolvimento adequado dos ovos.

Além disso, o uso do ESP8266 possibilita a automação de processos, como o acionamento de 

umidade e ventilação conforme necessário, o que aumenta as chances de sucesso na incubação. A 

conectividade Wi-Fi do ESP8266 ainda facilita o monitoramento remoto e o recebimento de alertas, 

tornando o sistema prático e confiável. Com baixo custo e fácil manutenção, esse tipo de chocadeira 

é uma solução acessível para pequenos produtores ou hobistas, unindo eficiência, autonomia e 

simplicidade.

Se você gosta de aprender coisas novas, a criação de uma chocadeira artesanal é um projeto 

incrível para experimentar! Construir a sua própria chocadeira não é apenas uma maneira 

econômica de começar na criação de aves, mas também oferece um aprendizado prático sobre 

eletrônica, automação e cuidado com os ovos. Ao fazer a sua chocadeira, você terá a liberdade de 

ajustar e personalizar o equipamento conforme necessário, além de sentir o orgulho de ver os 

primeiros pintinhos nascerem do seu próprio sistema.

E o melhor? Não é preciso ser um especialista em eletrônica! Com materiais acessíveis, como o isopor 

para isolamento e o ESP8266 para controle, você pode montar uma chocadeira eficiente e prática. 

Então, que tal arregaçar as mangas, explorar novas habilidades e criar algo que realmente faz a 

diferença? Além de ser gratificante, é um passo inspirador rumo à independência e ao autocuidado na 

criação.

Para obter sucesso na incubação, é essencial manter condições de temperatura, umidade e 

ventilação constantes e adequadas, pois esses fatores são críticos para o desenvolvimento dos 

embriões. Aqui estão algumas dicas finais para ajudar no processo:

Controle rigoroso da temperatura: O ideal é manter a temperatura em torno de 37,5°C para a 

maioria dos ovos de aves. Mesmo pequenas variações podem impactar negativamente o 

desenvolvimento do embrião. O monitoramento frequente é importante, especialmente em 

chocadeiras artesanais.

1.

Ajuste de umidade: Nos primeiros dias, uma umidade de 50-55% ajuda a evitar a perda excessiva 

de água dos ovos. Nos últimos dias de incubação, aumente para 65-70% para facilitar a eclosão. 

Monitore a umidade com cuidado e ajuste usando recipientes de água ou um borrifador.

2.

Ventilação adequada: O oxigênio é fundamental para o embrião em crescimento, especialmente à 

medida que ele se aproxima da eclosão. Certifique-se de que sua chocadeira tenha uma 

ventilação leve, permitindo a troca de ar sem perder muito calor ou umidade.

3.

Viragem regular dos ovos: Virar os ovos várias vezes ao dia evita que o embrião fique aderido à 

casca. Para ovos pequenos, vire 4 a 5 vezes por dia até cerca de três dias antes da eclosão, 

quando você deve interromper as viragens para preparar a eclosão.

4.

Monitorar constantemente as condições na chocadeira, especialmente em modelos artesanais, ajuda 

a corrigir pequenas variações antes que se tornem problemáticas. Esses ajustes fazem a diferença 

para garantir que os embriões estejam nas melhores condições para eclodirem saudáveis!

Encerramento
Agradecemos por nos acompanhar nesta jornada de aprendizado sobre criação de chocadeiras 

artesanais e os cuidados necessários para a incubação de ovos. Esperamos que essas 

informações inspirem e ajudem você a dar os primeiros passos nesse projeto apaixonante. Seja 

para a criação de aves ou para ampliar suas habilidades, estamos aqui torcendo pelo seu sucesso! 

Boa sorte e até a próxima!

Se você curte projetos DIY, automação e quer aprender ainda mais sobre criação artesanal, 

convidamos você a seguir nosso canal/blog! Estamos sempre compartilhando dicas, guias práticos 

e novas ideias para ajudar você a transformar seus projetos em realidade. Venha fazer parte dessa 

comunidade e descubra como levar suas habilidades ao próximo nível. Fique ligado para mais 

conteúdos inspiradores!

@https://www.youtube.com/@Dacidadepraroca-2000

https://www.instagram.com/dacidadepraroca/

https://www.youtube.com/@Dacidadepraroca-2000
https://www.instagram.com/dacidadepraroca/
https://gamma.app/?utm_source=made-with-gamma

